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Installing CD One

This chapter consists of:

• Installation Overview

• Preparing to Install CD One

• Performing a New Installation

• Performing an Upgrade Installation

• Verifying the Installation

• Uninstalling CD One
2-1
ide for CD One on Windows 2000



 

Chapter 2      Installing CD One
Installation Overview
Installation Overview
This section provides overview of CD One installation task. Table 2-1 contains 
references to more detailed information about each task. The table describes a 
typical local installation. 

For information on custom installation, refer to Custom Installation, page 2-12. 

For information on remote installation, refer to Performing an Upgrade 
Installation, page 2-16.

Table 2-1 Installing CD One Task Overview

Task Steps References

Prepare to install 
CD One.

1. Verify server requirements are 
met

“Prerequisites” chapter, “Server 
Requirements” section on page 1-3

2. Install required Microsoft 
software on the server if it is not 
already installed

“Installing Required Microsoft Software” 
section on page 2-4

3. Verify client requirements are 
met

“Prerequisites” chapter, “Client 
Requirements” section on page 1-4

4. TCP ports that CiscoWorks2000 
uses and check for conflicts with 
existing applications

“TCP and UDP Ports Used” section on 
page 2-6

Install server 
software.

Run installation program “Performing a New Installation” section 
on page 2-7

Verify and 
troubleshoot 
installation.

1. Verify all correct services are 
installed

“Verifying the Installation” section on 
page 2-27

2. Analyze installation error 
messages

“Troubleshooting the Installation” 
appendix, “Understanding Installation 
Messages” section on page A-4 
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Installation Notes
During installation, you might see warnings from the Windows 2000 system that 
it has found a read-only file. 

You might also see warnings that the installation system is running out of disk 
space. You can choose to free disk space on the system and click Yes to continue, 
or click No to exit the installation.

CD One is installed in the default directory C:\Program Files\CSCOpx. If you 
select another directory during the installation, CD One will be installed in that 
directory.

Note Do not select an encrypted directory. CiscoWorks2000 does not support directory 
encryption.

Preparing to Install CD One 
Before you install CD One, make sure your server and client environments meet 
the hardware and software requirements described in the “Prerequisites” chapter. 

You must be a member of the local administration group to install CD One. The 
following should be taken care of while preparing to install CD One:

• Do not use DHCP running in dynamic mode on the CiscoWorks2000 Server.

• Do not install CiscoWorks2000 on a system that is configured as a primary or 
backup domain controller, or as a terminal server or advanced server.

• Do not install CiscoWorks2000 on a FAT file system.

• Do not install CiscoWorks2000 on Windows XP.

Note If you are running HP OpenView, the installation might take significantly 
longer to complete. Please stop all HP OpenView services before 
installing CD One.
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Installing Required Microsoft Software
Depending on your system, installing CD One might require three or more 
Microsoft software application installations.The major steps required for 
installing the CD One software are:

1. Make sure the system has Microsoft Windows 2000 with service pack 2 
installed.

To verify the currently-installed service pack:

a. Select Start > Run.

b. Enter winver.

If version 5.0 Service Pack 2 appears in the Version field, Service 
Pack 2 is already installed.

If this information does not appear, Service Pack 2 is not installed. Install it now. 
Refer to the Microsoft web site.

2. Make sure Microsoft Internet Explorer 5.5 with Service Pack 2 is installed 
and is running JVM version 5.0.0.3802. For Microsoft Internet Explorer 6.0 
use the JVM version 5.0.0.3805. To verify the JVM version:

a. Select View > Java Console. 

b. If Java Console is not listed in View, enable it now. Select 
Tools> Internet Options >Advanced. 

c. In the Java VM section, select the Java Console option. 

d. Restart Internet Explorer.
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To download the supported JVM version, refer to the Microsoft web site. Make 
sure ODBC Driver Manager 3.520 or later is installed. To verify the version of 
ODBC Driver Manager:

a. For Windows 2000, select Start > Settings > Control Panel > 
Administrative Tools > ODBC.

b. Select the About tab. 

If necessary, install Microsoft Data Access Component (MDAC) 2.5 or later. 

Note Make sure that all ODBC Core Components have the same version 
number. 

Refer to the Microsoft web site for installation instructions.

Note The download and installation programs for these software packages 
might be changed by Microsoft at their discretion. 
Therefore, it is not possible to provide exact instructions for the 
installation of the required Microsoft software.

Key Installation Points

Remember these points when installing the required server software:

• Always keep the newer file whenever you are prompted by an installation 
program to replace a newer file with an older file.

• Always reboot your system when you are prompted to do so by an installation 
program.

• You might be asked to register with Microsoft before downloading some of 
the required software. Complete the registration. Selections you make during 
registration will not affect the installation.
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TCP and UDP Ports Used
CD One uses the following TCP and UDP ports:

Incoming Ports

• 42343/tcp (JRun)

• 57860/tcp (JRun Server Manager ControlServer - Used for Jrun 
Administration)

• 42344/tcp (ANI HTTP server)

• 514/udp (Standard port for Syslog)

• 1741/tcp (port used for the CiscoWorks2000 HTTP server)

• 1742/tcp (used when the webserver is running on SSL mode)

Refer to the “Preparing to Use CD One” chapter for information about 
accessing the server.

• Database ports: 43441-43449 (Different applications uses different ports.
For example, CD One uses 43441 and Essentials uses 43442)

Outgoing Ports

• 161/udp (Standard port for SNMP Polling)

• 162/udp (Standard port for SNMP Traps)

• 23/tcp (Standard port for Telnet)

• 22/tcp (Standard port for SSH)

• 80/tcp (Default HTTP for device navigator)

Incoming and Outgoing Ports

• 42340/tcp (CiscoWorks2000 Daemon Manager, the tool that manages server 
processes)

• 42342/udp (Osagent)

• 7580/tcp (default port; alternate port: 42352/tcp) (ESS HTTP port)
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• 69/udp (Standard port for TFTP)

• 1683 (IIOP port for CW2K gatekeeper)

• 8088 (HIOP port for CW2K gatekeeper)

• 514/tcp (RCP port)

• 7500/tcp (default port; alternate port: 42351/tcp) (ESS Listening port)

• 7588/tcp (default port; alternate port: 42353/tcp) (ESS Routing port)

• 7500/udp (default port; alternate port: 42350/udp (ESS Service port)

Performing a New Installation
The CD One installation program takes approximately 30 minutes to complete on 
a Windows machine with the minimum required hardware. This can extend to one 
hour if you perform network management integration during the installation 
process. 

For information on setting up multi-homed machines, refer to the Release Notes 
for CD One, 5th Edition. 

Running the Installation Program—New Installation
To run the installation program:

Step 1 Install the required software as described in the “Server Requirements” section on 
page 1-3.

Caution If you are running Windows 2000, make sure Service Pack 2 is installed. Without 
the appropriate service pack installed, CD One will install with a warning to 
proceed at your own risk. 

Step 2 Insert the CD One CD-ROM into a CD-ROM drive. 

The Installer screen appears.

Step 3 Click Install to continue. 

The Welcome screen appears.
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Step 4 Click Next to continue. 

The Setup Type dialog box appears.

Step 5 Select one of the following:

• Typical to install all CD One components in the default location
(Refer to the “Typical Installation” section.)

• Custom to select optional components and to specify the location
(Refer to the “Custom Installation” section.)

Typical Installation
If you select the typical option: 

Step 1 Click Next to continue. 

The Start Copying Files dialog box appears, verifying current settings.

The Select Components dialog box appears.

Step 2 Select one of the following:

Note If CD One has previously been installed on this machine, the list of 
components will be different.

1. NMS Integration Utility to install only the Integration Utility.
(For information about the Integration Utility and third-party NMS 
integration, refer to Using CiscoView.) 

2. Common Management Foundation (CMF) Base Desktop to install a 
subset of CMF.
(Select this option only if the application you’ll be installing next requires the 
CMF Base Desktop and you do not want CiscoView or NMS Integration 
Utility installed.)

3. CiscoView to install only CiscoView.

4. CiscoView, NMS Integration Utility, and CMF to install all CD One 
components (recommended for most systems).
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Step 3 Click Next to continue. 

The installation program checks dependencies and system requirements. The 
Requirements Verification dialog box appears. Click OK. 

The installation of CD One progresses.

A message may display:

User casuser already exists. Casuser is the user who administers and 
maintains CW2000 server without having root privileges. Installation 
will reset the password for security reasons.
Do you want to proceed with the installation?

Note If you are installing for the first time the following message will appear: 
Installation will create user casuser. Casuser is the user who 

administers and maintains CW2000 server without having root 

privileges.Do you want to proceed with the installation?

Step 4 Click Yes if you receive the casuser message. 

A messages displays:

By default install will select randam password for casuser. Do you 
want to change password for casuser?

Click Yes to change the password and the CiscoWorks2000 change password 
dialog box appears. Enter the password and confirm it.

The installation program adds the new user casuser and the new group casusers 
to the system.

The Installation program displays:

For security reasons, Cisco recommends that you change the default 
password for Admin user. Do you want to change it now?

Step 5 Click Yes to change the password and the CiscoWorks2000 change password 
dialog box appears. Enter the password and confirm it.

If you click No, skips to next step.

The Installation program displays:

For security reasons, Cisco recommends that you change the default 
password for Guest user. Do you want to change it now?

Step 6 Click Yes to change the password and the CiscoWorks2000 change password 
dialog box appears. Enter the password and confirm the password.
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If you click No, skips to next step.

The Installation program displays:

For security reasons, Cisco recommends that you change the default 
password for CMF Database. Do you want to change it now?

Step 7 Click Yes to change the password and the CiscoWorks2000 change password 
dialog box appears. Enter the password and confirm the password.

If you click No, skips to next step.

The Installation program displays:

For security reasons, Cisco recommends that you change the default 
password for ANI Database. Do you want to change it now?

Step 8 Click Yes to change the password and the CiscoWorks2000 change password 
dialog box appears. Enter the password and confirm the password.

If you click No, skips to Step 9

The installation script checks dependencies, and the Integration Utility dialog box 
appears.

Step 9 Select one of the following:

• Later to integrate with a third-party NMS after installation. Later is the 
recommended choice to complete the installation more quickly, and to avoid 
installation failure due to errors in the third-party integration. 
If you select Later, go to Step 10.

• Now to integrate with a third-party NMS during installation.
If you select Now, continue with steps a through c.

a. Click Next to continue. 

The Integration Utility dialog box appears, displaying a list of adapters.

b. Select the adapter from the list of available adapters, or select other to choose 
an adapter that is not listed (you will be prompted to enter the path name of 
the adapter), or select none to integrate after the installation is complete.
If you select none, go to Step 10.
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The Integration Utility dialog box appears, asking if you want to enable download 
options from the Cisco Web page (CCO). 

c. Select one of the following:

• No to not enable future upgrades from the Cisco Web page. 

• Yes to enable future upgrades from the Cisco Web page.
Enter your CCO user ID and password.

Note You must have CCO login privileges. If you do not have a user 
account and password on CCO, contact your channel partner or enter 
a request on the standard CCO web site (www.cisco.com).

Step 10 Click Next to continue.

Note A dialog box might display services that are running. To stop the services 
and continue the installation, click Yes.

When the installation is complete, the Restart dialog box appears, asking if you 
want to restart your system. 

Step 11 Select Yes, then click Finish.

CD One is installed in the default directory, 
<windows system drive>:\Program Files\CSCOpx.

Step 12 Prepare the client system for use. Refer to the “Preparing to Use CD One” chapter.

Caution You must restart your system when installation is complete to restart the 
processes.

Note For troubleshooting information or to verify the directories installed on your 
system, Refer to the “Troubleshooting the Installation” appendix.
2-11
Installation and Setup Guide for CD One on Windows 2000

78-14068-01



 

Chapter 2      Installing CD One
Performing a New Installation
Custom Installation
If you select the custom option:

Step 1 Click Next to continue. 

The Select Destination dialog box appears.

Note If CD One has previously been installed on this machine, the Select 
Destination dialog box will not appear and the product will automatically 
be installed in the same location CD One was previously installed.

Step 2 Click Next to accept the default location, or select a different location then click 
OK, then Next. 

Note Do not select an encrypted directory. CiscoWorks2000 does not support 
directory encryption.

The Select Components dialog box appears.

Step 3 Select one of the following:

Note If CD One has previously been installed on this machine, the list of 
components will be different.

• NMS Integration Utility to install only the Integration Utility.
(For information about the Integration Utility and third-party NMS 
integration, refer to Using CiscoView.) 

• Common Management Foundation (CMF) Base Desktop to install a 
subset of CMF.
(Select this option only if the application you’ll be installing next requires the 
CMF Base Desktop and you do not want CiscoView or NMS Integration 
Utility installed.)

• CiscoView to install only CiscoView.

• CiscoView, NMS Integration Utility, and CMF to install all CD One 
components (recommended for most systems).
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Step 4 Click Next to continue. 

The Start Copying Files dialog box appears, verifying current settings and 
selected components.

Note If you selected the Cisco View or the CMF Base Desktop option, go to 
Step 13.

Step 5 Click Next to continue. 

The installation program checks dependencies and system requirements. The 
Requirements Verification dialog is displayed. 

Step 6 Click OK. The installation of CD One progresses.

A message may display:

User casuser already exists. Casuser is the user who administers and 
maintains CW2000 server without having root privileges. Installation 
will reset the password for security reasons.
Do you want to proceed with the installation?

Note If you are installing for the first time the following message will appear: 
Installation will create user casuser. Casuser is the user who 

administers and maintains CW2000 server without having root 

privileges.Do you want to proceed with the installation?

Step 7 Click Yes if you receive the casuser message. 

A messages displays:

By default install will select randam password for casuser. Do you 
want to change password for casuser?

Click Yes to change the password in the CiscoWorks2000 change password dialog 
box.

The installation program adds the new user casuser and the new group casusers 
to the system.

Click Yes to change the password and the CiscoWorks2000 change password 
dialog box appears. Enter the password and confirm the password.

The installation program adds the new user casuser and the new group casusers 
to the system.
2-13
Installation and Setup Guide for CD One on Windows 2000

78-14068-01



 

Chapter 2      Installing CD One
Performing a New Installation
The Installation program displays:

For security reasons, Cisco recommends that you change the default 
password for Admin user. Do you want to change it now?

Step 8 Click Yes to change the password and the CiscoWorks2000 change password 
dialog box appears. Enter the password and confirm the password.

If you click No, skips to next step.

The Installation program displays:

For security reasons, Cisco recommends that you change the default 
password for Guest user. Do you want to change it now?

Step 9 Click Yes to change the password and the CiscoWorks2000 change password 
dialog box appears. Enter the password and confirm the password.

If you click No, skips to next step.

The Installation program displays:

For security reasons, Cisco recommends that you change the default 
password for CMF Database. Do you want to change it now?

Step 10 Click Yes to change the password and the CiscoWorks2000 change password 
dialog box appears. Enter the password and confirm the password.

If you click No, skips to next step.

The Installation program displays:

For security reasons, Cisco recommends that you change the default 
password for ANI Database. Do you want to change it now?

Step 11 Click Yes to change the password and the CiscoWorks2000 change password 
dialog box appears. Enter the password and confirm the password.

If you click No, skips to Step 12

The installation script checks dependencies, and the Integration Utility dialog box 
appears.
2-14
Installation and Setup Guide for CD One on Windows 2000

78-14068-01



 

Chapter 2      Installing CD One
Performing a New Installation
Step 12 Select one of the following:

• Later to integrate with a third-party NMS after installation. Later is the 
recommended choice to complete the installation more quickly, and to avoid 
installation failure due to errors in the third-party integration.
If you select Later, go to Step 13.

• Now to integrate with a third-party NMS during installation.
If you select Now, continue with steps a through c.

a. Click Next to continue. 

The Integration Utility dialog box appears, displaying a list of adapters.

b. Select the adapter from the list of available adapters, or select other to choose 
an adapter that is not listed (you will be prompted to enter the path name of 
the adapter), or select none to integrate after the installation is complete.
If you select none, go to Step 13.

The Integration Utility dialog box appears, asking if you want to enable download 
options from the Cisco Web page (CCO).

Note If you are installing only the Integration Utility, enter the CiscoWorks2000 server 
name, protocol type (HTTP, HTTPS) and port number.

c. Select one of the following:

• No to not enable future upgrades from the Cisco Web page. 

• Yes to enable future upgrades from the Cisco Web page.

• Enter your CCO user ID and password.

Note You must have CCO login privileges. If you do not have a user 
account and password on CCO, contact your channel partner or enter 
a request on the standard CCO web site (www.cisco.com).

Step 13 Click Next to continue. 

Note A dialog box might display services that are running. To stop the services 
and continue the installation, click Yes.
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When the installation is complete, the Restart dialog box appears, asking if you 
want to restart your system.

Step 14 Select Yes, then click Finish.

CD One software is installed in the default directory, 
<windows system drive>\Program Files\CSCOpx, or the directory specified.

Step 15 Prepare the client system for use. Refer to the “Preparing to Use CD One” chapter.

Caution You must restart your system when installation is complete to restart the 
processes.

Note For troubleshooting information, Refer to the “Troubleshooting the Installation” 
appendix.

Performing an Upgrade Installation
CD One, 5th edition supports upgrade from CD One, 4th edition only. Upgrade 
from other CD One releases is not supported. The data is preserved when you 
perform an upgrade.

For a description of the different upgrade paths and their results, refer to the “CD 
One Upgrade” section on page 1-2.

Upgrading from CD One, 4th Edition
You can upgrade to the new version of CD One using either of two methods. You 
can perform a local upgrade by installing the new version on the machine 
currently running a previous version. 

As an alternative, you can perform a remote upgrade by installing 
CD One, 5th Edition, on a new machine, and exporting essential data from the 
machine running the CD One, 4th edition to the new machine. 
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To perform a local upgrade from CD One, 4th edition, Refer to the “Upgrading 
from CD One, 4th Edition—Local Upgrade” section on page 2-17.

To perform a remote upgrade from CD One, 4th edition, Refer to the “Upgrading 
from CD One, 4th Edition—Remote Upgrade” section on page 2-25.

Upgrading from CD One, 4th Edition—Local Upgrade

You can save your data to a backup file before you perform the local upgrade. If 
your installation fails, you can retrieve this saved data. 

Backing Up Your Data

To backup the data:

Step 1 Access the CiscoWorks2000 desktop and log in. For information, see the 
"Accessing the Server" section and the "Logging In" section in the User Guide for 
CiscoWorks2000 Server.

Step 2 Select Server Configuration > Administration > Database Management > 
Back Up Data Now.

The Back Up Data Now dialog box appears.

Step 3 Enter the pathname of the target directory. It is recommended that you use a 
different directory from the directory where CiscoWorks2000 is located, for 
example, C:\backups.

Step 4 To begin the backup, click Finish. This process could take some time to complete.

For more information, see the online help.

Before starting an upgrade from CD One, 4th Edition, all currently scheduled jobs 
must be suspended. Necessary data can then be exported during upgrade to the 
new version. This data to the new version allows individual applications to 
re-enable jobs after upgrade. To make this possible, you must first install a patch 
on the old system. The patch is shipped with CD One, 5th edition.
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Installing the Patch

To install the patch:

Step 1 Insert the CD One, 5th edition CD-ROM into a CD-ROM drive. 

Step 2 At the command line, enter:

perl patch_1x_20.pl

The patch copies the file DisableJobs.class to the runtime installation directory. 

Step 3 At the command line, enter:

cwjava -cw <install_directory> com.cisco.nm.cmf.jrm.DisableJobs

The class file suspends all the jobs and creates a list of job IDs for the suspended 
jobs and other job information in a file called joblist.jrm. The file joblist.jrm is 
saved in $NMSROOT/setup. Jobs are re-enabled as part of the upgrade process for 
individual applications.

Now that the patch is installed, you can install CD One, 5th Edition.

Run the Installation Program

To run the installation program:

Step 1 Install the required software as described in the “Server Requirements” section on 
page 1-3.

Caution If you are running Windows 2000, make sure Service Pack 2 is installed. Without 
the appropriate service pack installed, CD One installer will display a warning to 
proceed at your own risk.

Step 2 Insert the CD One CD-ROM into a CD-ROM drive. 

The Installer screen appears.

Step 3 Click Install to continue. 

The Welcome screen appears.
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Step 4 Click Next to continue. 

The Setup Type dialog box appears.

Step 5 Select one of the following:

• Typical to install all CD One components in the default location
(Refer to the “Local Upgrade from CD One, 4th Edition—Typical” section.)

• Custom to select optional components and to specify the location
(Refer to the “Local Upgrade from CD One, 4th edition—Custom” section.)

Local Upgrade from CD One, 4th Edition—Typical 

If you select the typical option:

Step 1 Click Next to continue. 

The Start Copying Files dialog box appears, verifying current settings.

Step 2 Click Next to continue. 

The installation program checks dependencies and system requirements. The 
Requirements Verification dialog box appears. Click OK. 

The installation of CD One progresses.

A message displays:

User casuser already exists. Casuser is the user who administers and 
maintains CW2000 server without having root privileges. Installation 
will reset the password for security reasons.
Do you want to proceed with the installation?

Step 3 Click Yes if you receive the casuser message. The installation program adds the 
new user casuser and the new group casusers to the system.

A messages displays:

By default install will select randam password for casuser. Do you 
want to change password for casuser?

Click Yes to change the password and the CiscoWorks2000 change password 
dialog box appears. Enter the password and confirm the password.

The installation program adds the new user casuser and the new group casusers 
to the system.
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The Installation program displays:

For security reasons, Cisco recommends that you change the default 
password for Admin user. Do you want to change it now?

Step 4 Click Yes to change the password and the CiscoWorks2000 change password 
dialog box appears. Enter the password and confirm the password.

If you click No, skips to next step.

The Installation program displays:

For security reasons, Cisco recommends that you change the default 
password for Guest user. Do you want to change it now?

Step 5 Click Yes to change the password and the CiscoWorks2000 change password 
dialog box appears. Enter the password and confirm the password.

If you click No, skips to next step 

The Installation program displays:

For security reasons, Cisco recommends that you change the default 
password for CMF Database. Do you want to change it now?

Step 6 Click Yes to change the password and the CiscoWorks2000 change password 
dialog box appears. Enter the password and confirm the password.

If you click No, skips to next step

The Installation program displays:

For security reasons, Cisco recommends that you change the default 
password for ANI Database. Do you want to change it now?

Step 7 Click Yes to change the password and the CiscoWorks2000 change password 
dialog box appears. Enter the password and confirm the password.

If you click No, skips to Step 9

The installation script checks dependencies, and the Integration Utility dialog box 
appears.
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The Integration Utility dialog box may appear. If your previous version of 
CiscoWorks2000 is already integrated with a third-party NMS, and skip to Step 8.

Step 8 Select one of the following:

• Later to integrate with a third-party NMS after installation. Later is the 
recommended choice to complete the installation more quickly, and to avoid 
installation failure due to errors in the third-party integration. 
If you select Later, and click next to continue.

• Now to integrate with a third-party NMS during installation.
If you select Now, continue with steps a through c.

a. Click Next to continue. The Integration Utility dialog box appears, displaying 
a list of adapters.

b. Select the adapter from the list of available adapters, or select other to choose 
an adapter that is not listed (you will be prompted to enter the path name of 
the adapter), or select none to integrate after the installation is complete.
If you select none, go to Step 5.

The Integration Utility dialog box appears, asking if you want to enable download 
options from the Cisco Web page (CCO).

c. Select one of the following:

• No to disallow future upgrades from the Cisco Web page. 

• Yes to enable future upgrades from the Cisco Web page.

• Enter your CCO user ID and password.

Note You must have CCO login privileges. If you do not have a user 
account and password on CCO, contact your channel partner or enter 
a request on the standard CCO web site (www.cisco.com).

Note A dialog box might display services that are running. To stop the services 
and continue the installation, click Yes.
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When the installation is complete, the Restart dialog box appears, asking if you 
want to restart your system.

Step 9 Select Yes, then click Finish.

CD One software is installed in the default directory, C:\Program Files\CSCOpx, 
or the directory specified.

After the upgrade is complete, all jobs are in a suspended state. Jobs are 
re-enabled as part of the upgrade process for individual applications.

Step 10 Prepare the client system for use. Refer to the “Preparing to Use CD One” chapter.

Caution You must restart your system when installation is complete to restart the 
processes.

Note If you cannot install CD One, Refer to the “Troubleshooting the Installation” 
appendix.

Local Upgrade from CD One, 4th edition—Custom 

If you select the custom option:

Step 1 Click Next to continue. 

The Select Destination dialog box appears.

Note If CD One has previously been installed on this machine, the Select 
Destination dialog box will not appear and the product will automatically 
be installed in the same location CD One was previously installed.
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Step 2 Click Next to accept the default location, or select a different location then click 
OK, then Next. 

Note Do not select an encrypted directory. CiscoWorks2000 does not support directory 
encryption.

The Select Components dialog box appears.

Step 3 Select one of the following:

Note If CD One has previously been installed on this machine, the list of 
components will be different.

• NMS Integration Utility to install only the Integration Utility.
(For information about the Integration Utility and third-party NMS 
integration, refer to Using CiscoView.) 

• Common Management Foundation (CMF) Base Desktop to install a 
subset of CMF.
(Select this option only if the application you’ll be installing next requires the 
CMF Base Desktop and you do not want CiscoView or NMS Integration 
Utility installed.)

• CiscoView to install only CiscoView.

• CiscoView, NMS Integration Utility, and CMF to install all CD One 
components (recommended for most systems).

Step 4 Click Next to continue. 

The Start Copying Files dialog box appears, verifying current settings and 
selected components.

Note If you selected the Cisco View or the CMF Base Desktop option, go to 
Step 13.

Step 5 Click Next to continue. 
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The Requirements Verification dialog is displayed. The installation checks 
dependencies, and the Integration Utility dialog box appears.

Step 6 Select one of the following:

• Later to integrate with a third-party NMS after installation. Later is the 
recommended choice to complete the installation more quickly, and to avoid 
installation failure due to errors in the third-party integration.
If you select Later, go to Step 13.

• Now to integrate with a third-party NMS during installation.
If you select Now, continue with steps a through c.

a. Click Next to continue. The Integration Utility dialog box appears, displaying 
a list of adapters.

b. Select the adapter from the list of available adapters, or select other to choose 
an adapter that is not listed (you will be prompted to enter the path name of 
the adapter), or select none to integrate after the installation is complete.
If you select none, go to Step 13.

The Integration Utility dialog box appears, asking if you want to enable download 
options from the Cisco Web page (CCO).

Note If you are installing only the Integration Utility, enter the CiscoWorks2000 server 
name, protocol type (HTTP, HTTPS) and port number.

c. Select one of the following:

• No to not enable future upgrades from the Cisco Web page. 

• Yes to enable future upgrades from the Cisco Web page.
Enter your CCO user ID and password.

Note You must have CCO login privileges. If you do not have a user 
account and password on CCO, contact your channel partner or enter 
a request on the standard CCO web site (www.cisco.com).

Note A dialog box might display services that are running. To stop the services 
and continue the installation, click Yes.
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When the installation is complete, the Restart dialog box appears, asking if you 
want to restart your system.

Step 7 Select Yes, then click Finish.

CD One software is installed in the default directory, C:\Program Files\CSCOpx, 
or the directory specified.

After the upgrade is complete, all jobs are in a suspended state. Jobs are 
re-enabled as part of the upgrade process for individual applications.

Step 8 Prepare the client system for use. Refer to the “Preparing to Use CD One” chapter.

Caution You must restart your system when installation is complete to restart the 
processes.

Note For troubleshooting information, Refer to the “Troubleshooting the Installation” 
appendix.

Upgrading from CD One, 4th Edition—Remote Upgrade

If you do not want to overwrite your current version of CD One, you can perform 
a remote upgrade. During a remote upgrade, you install CD One, 5th Edition, on 
a new machine, and export all required data to the new machine from the machine 
running the previous version. 

Step 1 Install CD One, 5th edition on the new machine. Refer to the “Performing a New 
Installation” section on page 2-7.

Step 2 Remove the CD One CD-ROM from the new machine.
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Before starting an upgrade to CD One, 5th Edition, relevant data from all jobs 
must be exported to the new system. To make this possible, you must first install 
a patch on the old system. The patch is shipped with CD One, 5th edition.

To install the patch:

Step 1 Insert the CD One CD-ROM into the CD-ROM drive of the machine running the 
previous version of CD One. 

Step 2 At the command line, enter:

perl patch_1x_20.pl

Now that you have installed the patch, you can export the necessary job data from 
the old machine to the new one.

To export the data:

Step 1 The CD One CD-ROM should be in the CD-ROM drive of the machine running 
the old version of CD One. Go to the root directory on the CD One CD-ROM.

Step 2 Execute perl export_cdone.pl.

Step 3 Copy the directories $NMSROOT/rigel/cmf and $NMSROOT/rigel/manifest from the 
machine running the old version of CD One into the corresponding directories on 
the machine running the new version of CD One.

Step 4 On the new machine, go to the directory $NMSROOT/rigel/scripts, and 
execute perl import_cdone.pl.

The upgrade is now complete, and all necessary job data from the previous version 
of CD One has been exported.

Note All passwords will be reset to the corresponding passwords of CD One, 4th 
Edition.
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Reinstalling CD One, 5th Edition
The reinstallation procedures are the same as that for a new installation. 

Note If CD One has previously been installed on this machine, the product will 
automatically be installed at the same location where CD One was 
previously installed.

Verifying the Installation
You can verify product installation by entering the command net start from a 
DOS prompt. The following services should be displayed:

• Apache WebServer

• CMF rsh/rcp service

• CMF syslog service

• CMF tftp service

• CW2000 Daemon Manager

• CW2000 VisiBroker Smart Agent

• JRun Proxy Server for CW2000

Note If you installed the CMF Base Desktop only, CW2000 VisiBroker Smart Agent 
will not be displayed.
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Uninstalling CD One
Use the Uninstall option to remove CD One files and settings. You must be logged 
in as a local administrator to remove CD One.

Caution You must use the Uninstall option of the CD One installation program to remove 
the product. If you try to remove CD One or its components manually, you can 
damage your system.

Step 1 From the Windows desktop, select 
Start>Programs>CiscoWorks2000 >Uninstall CiscoWorks2000. 

The Uninstallation dialog box appears, displaying installed components.

Step 2 Select each component you want to remove.

Step 3 Click Next to begin uninstalling, then click Next again.

Messages about uninstall preparation appear and the uninstallation finishes. 
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